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Achyutam keshavam flute ringtone

The first step in adding a ringtone to your phone is finding one that you like. Generally, this means checking out one of the dozens of ringtone sites on the Internet and picking a good one that's compatible with your phone model. Some sites charge for the use of their ringtones, to cover song royalties, among other things, and some sites provide tones for free. A lot of older songs
(such as classical pieces) have been around long enough that their copyright has expired -- they've entered the public domain, so they're free for anybody to use.Once you've found a ringtone you like, you just have to get it into your phone's memory. There are a number of different ways to do this, depending on your particular phone model. The three major ways to add a new
ringtone are:Load the ringtone program into the phone from a computer, via a data cable.Send the program to the phone over the airwaves.Type the program into the phone directly, using the keypad.Phones may use one particular method exclusively, but a lot of phones have multiple options. Check your instruction manual to find out what your phone can do.If you have the right
phone, software and computer configuration, loading ringtones through a data link or infrared interface may be the simplest option, but it requires some work and expenditure to set everything up initially.A more popular method is to send the new ringtone to your phone over the airwaves. This approach originated with Nokia, but other manufacturers have since added this capability
to their phones. The basic idea is to send the phone a special sort of text message that contains the program for the ringtone -- in most phones, this is done using either Short Message Service or Enhanced Messaging Service technology.Nokia originally developed Short Message Service to send short text messages between phones. Later, Nokia and Intel created smart
messaging, a special protocol for sending functional, non-text information through SMS. Basically, a "smart" SMS message is coded to allow the equipped phone to recognize it as a graphic, ringtone, etc.The most common method for transferring ringtones over the airwaves is to visit a ringtone Web site, pick out a tone, enter your phone number and let the site administrators send
the message to your phone directly. Alternatively, you can use an SMS gateway site to send a specific message to the phone yourself. This means finding the code for the ringtone you want, finding it in the appropriate format (Nokia binary format, for example) and copying it at as a smart message.Cell phones with a melody composer let you type in ringtones directly. The easiest
way to use this feature is to find the appropriate "keypress sequence" for a tune on the Web. This sequence will tell you which buttons to press on your phone, in composer mode, to program the ringtone you want (check your instruction manual for details on your phone's composer mode). Of course, for the ringtone to work, the sequence has to be in the right format. Fortunately,
you can find tons of sequences online for most phone models.As cell phones evolve, ringtones will get more complex as well. Already, some phones are boasting polyphonic ringtone capability, meaning the phone can play more than one note at a time, allowing for richer, harmonized tunes. Some new phones let you record songs and voice messages for ringtones yourself. Many
of these models also let you assign different ringtones to different incoming numbers, so you know who's calling you without even looking at your phone. Before long, ringtones will have graduated from an extraneous thrill to an essential phone feature.For details on various ringtone formats, as well as hundreds of available ringtones online, check out the links on the next page.
Smartphone ringtones are not typically something you think about — until you hear yours and want to change it to something more enjoyable and original. While the preset ringtones available on iPhones are functional, it’s easy to get bored with hearing the same ones over and over for years on your own phone and those of your friends and family. It’s good to know that there are
more ringtone options than Apple’s diverse but limited selection. If you’re looking for a novel way to customize your iPhone, try creating your own original ringtones. There are no limits to the songs and sounds you can use to create an arresting ringtone. See more Best iPhone apps How to reset your iPhone The best iPhone games Create a ringtone using Apple iTunes or Music
Step 1: Open and update Apple iTunes or Music Start by launching iTunes (MacOS 14 High Sierra or older) or Music (MacOS 15 Catalina or newer) on your Mac or Windows desktop or laptop computer. Make sure that you’re using the latest version of iTunes or Apple Music. To check in MacOS High Sierra or earlier, click iTunes in the application toolbar and select Check for
Updates from the resulting drop-down menu. If you’re using the latest version of Windows 10, click the Help option in the menu bar below the playback buttons, and select Check for Updates near the bottom of the resulting drop-down list. If you are running MacOS Catalina or newer, launch the App Store app and choose Updates in the App Store toolbar. Use the Update button to
download and install the newest version, if needed. Depending on how old your music is, you may have to deal with removing digital rights management (DRM) protection from your track first before using it as a ringtone. Also, make sure your chosen tune is downloaded to your Mac. A download icon next to your song means it resides in the cloud, so if it is, then click to download
it to your hard drive. Step 2: Choose a song Here’s the fun part — pick the song that you’d like to use as your new iPhone ringtone. Keep in mind iPhone ringtones play continuously in 30-second (or less) loops, so don’t pick something dumb or embarrassing. Once you’ve chosen your song, take note of the start and stop times for the 30-second piece you want to use. Step 3: Add
the start and stop times One of the lesser-known features of iTunes and Music is the ability to crop songs and videos, letting you choose specific start and end times. That is how to select a portion of a song to use as a ringtone. First, right-click or Ctrl-click the song you want and select Song Info (Get Info in MacOS Catalina or newer) from the resulting drop-down list. Then
click the Options tab at the top of the window. There should be fields for Start and Stop. Enter the times you want. Remember that ringtones max out at 30 seconds, so keep it at or below that length. Once done, click OK at the bottom. The iTunes and Music interface differ slightly but the process on both is the same. Step 4: Create an AAC version Apple’s preferred audio format is
AAC because it offers similar sound quality to an MP3, but takes up less storage space. Both iTunes and Music let you create an AAC version of any song you choose. Once you’ve set your start and stop times and have the song selected, go to File > Convert > Convert to AAC Version or in Music Create AAC Version. Because the start and stop times for the song have been set,
creating an AAC version will create a copy of that specific section of the song. The copy will then automatically appear in your iTunes library, directly beneath the original song, cropped to your chosen 30 seconds. Before doing anything else, go back into the original song’s Info page and revert the start and stop times to their original settings. Step 5: Copy the file and delete the old
one Once created, click the AAC version of your song and drag it to the desktop or your desired save location. This will copy the file to that location. You probably don’t need the shortened song in iTunes anymore, so feel free to delete the file. Right-click or Ctrl-click the AAC file in iTunes, and select Delete from Library from the resulting drop-down menu. Then, click the Delete
File button in MacOS High Sierra or earlier or choose Keep File or Move to Trash in MacOS Catalina. Change the extension and set your ringtone Step 6: Change the extension AAC files typically use the file extension .m4a, which you might notice when you click on your AAC file. For ringtones, however, iTunes uses the .m4r extension, which is essentially the same as .m4a with
a different name. This means you’ll need to change the extension from .m4a to .m4r in order to use the clip as a ringtone. Navigate to the desktop — or wherever you saved the file — click the file’s name, and change the extension from .m4a to .m4r. Click the Use .m4r or Yes button in the resulting alert window to confirm the changes. Show file extensions in Windows If you’re
using Windows you might find that you’re unable to change the file extension, at least by default. This is probably because your system is set to hide file extensions. To change this, open the Control Panel from the Start menu — you can also search for the Control Panel app in Windows 10 — and select Appearance and Personalization. Next, click File Explorer Options. Now, click
the View tab, uncheck the box beside Hide extensions for known file types, and click the Apply button at the bottom of the window. Now you should be able to see and edit the file extension. Step 7: Add file to your iPhone To add the .m4r ringtone file to your iPhone, connect your device to your computer using a lightning-to-USB cable. Then, select the iPhone icon in the upper-left
corner. Go to the Summary section and scroll down to Options. Check the box beside Manually manage music and videos and click Apply. Now, drag the .m4r file into the Tones tab located under On My Device, which will automatically sync the ringtone with your iPhone. If you’re having issues dragging the .m4r file to the Tones tab after you apply the changes, disconnect your
iPhone and restart iTunes. Then, connect your iPhone and try dragging the file into the window again. If you’re using MacOS Catalina (or newer) and don’t have iTunes, then open the Finder, and click your iPhone in the sidebar. If it’s the first time you’ve done this since updating, you may need to click the Trust button and go through the process to open your iPhone to your Mac.
From there, the steps are similar. Select the General tab, check the box beside Manually manage music and videos, and click Apply. There’s no Tones tab, so just drag your ringtone file to the name of your iPhone above the General tab. That will sync your new ringtone to your phone. Step 8: Set your ringtone For iOS 13, go to Settings > Sounds & Haptics > Ringtone and select
your ringtone from the top of the resulting list. For iOS 14, go to Settings > Sounds > Ringtone. Keep in mind you can always set the new ringtone as your text, voicemail, or email tone in addition to your notification sound for Facebook posts and tweets. A tone is a tone as far as Apple is concerned, so you can use it as the default sound for any notification or alert. How to create a
ringtone using GarageBand You may prefer to make your ringtone in Apple’s GarageBand app by either snipping a portion of a song you like or by creating your own. You can create a ringtone on your Mac using GarageBand and share it to your iCloud Drive so you can open it in GarageBand on your iPhone. To share songs from your Mac to GarageBand for iOS, you need to
enable iCloud Drive, so begin by setting up iCloud Drive on your Mac and your iPhone. Once it’s on your iPhone, export the song as a ringtone from GarageBand, or just create the ringtone directly on your iPhone. Use GarageBand for iOS This is easiest if you have the GarageBand iOS app and the music track you want to use on your iPhone already. Launch the GarageBand
app and find the song you want to use. Note that if you haven’t shortened it to 30 seconds already, GarageBand can do that automatically, though it may not be the 30 seconds you intend. Touch and hold the song, then choose Share > Ringtone. Name the ringtone and tap Export. Tap Use sound as and pick Standard Ringtone, Standard Text Tone, or Assign to Contact. From a
track on your Mac Here is one method you can use with an existing tune running MacOS Big Sur and GarageBand 10.3.5 — both the newest versions available. Open GarageBand on your Mac, click Empty Project, and then click Choose. Select the Audio microphone icon and click Create. Click View > Show Media Browser to reveal your resident tunes. Choose a tune you want
and drag your selection from the media browser into the workspace. Move your cursor to the bottom left or right corner of the track, and you will see an icon you can use to click and drag to shorten or lengthen the track to the specific portion you want to use for your ringtone. After you’ve selected a 30-second audio clip, right-click and find the Split at Playhead option. Right-click
again and choose Delete to remove the remainder of the tune so that only the 30-second interval remains. Click Share. You can either export the song to iTunes or Music on the desktop or as a GarageBand for iOS file from the Share menu. If you choose the former, follow Step 7 from the computer section above. If your iPhone has the GarageBand app downloaded, you can keep
the file as a GarageBand file and import it to your phone. From there, you can follow the instructions above to set it as a ringtone. Create a track using GarageBand loops You could also construct a custom song out of the loops available in GarageBand. Here’s how. Create an Empty Project, then click Choose, click the microphone button, and click Create. In the upper-right
corner, click the Loop icon in the middle (it looks like a loop). You’ll be able to search a loop library. To listen to them, pull them to the track field. Arrange them however you like, keeping the same loop playing over and over or adding in other loops on separate tracks to create more layered songs. Once you’ve finished, click Share, then Song to Music. You can choose the m4a file
type for exporting, then change the extension to m4r so you can copy it to your phone. Or Share Project to GarageBand for iOS and add it as a ringtone from iCloud. Editors' Recommendations If you’ve gotten sick of the ringtones that come with your Android phone or iPhone, it’s easy enough to buy new ones. But before you do that, there are a number of sites where you can get
free ringtones. We’ve rounded up some of the best. Will My Phone Support All Ringtones? If you own an Android device, things are simple. You can download ringtones to your Android phone directly, since it supports MP3 files as ringtones. You can even create your own custom ringtones for Android if you want. RELATED: How to Create Custom Ringtones for Your Android
Phone With iPhone, things are a little different. Most of the sites we’ve included in this article let you download MP3 files. But, the iPhone requires ringtones to be in their own AAC format, and they have an .m4r file extension. You can use MP3 ringtones, but you’ll have to download them to a PC and convert them before you can use them on your iPhone. We’ve got a full guide on
adding custom ringtones to your iPhone that covers how to do that conversion in iTunes and then transfer the ringtones to your phone. You can even use that same technique to make ringtones out of your own music or sounds. RELATED: How to Add Custom Ringtones to Your iPhone Is Downloading Ringtones from the Internet Safe? That all depends on where you get them,
and which ones you download. There are plenty of shady websites on the Internet that try to lure you in with free ringtones. A good test is to see if the website is full of ads or asks you for money. Another common tactic is that websites will show you some ringtones, but when you click the link, the site tries to download something else. Always pay attention to the file extension to
see if you’re downloading the file that you requested. An executable file extension (exe, msi, dmg, apk) is a huge red flag. Then there is the issue of legality. Most websites have a mix of ringtones, some legal and some not. Obviously, if you’re getting ringtones for songs from the last several decades, they’re probably not not legal, and we would recommend that you stay away
from them. It would be safer to buy ringtones like that or, if you already own the song, to make your own ringtone from it. So, with that out of the way, here are our top websites for downloading ringtones. Zedge Zedge hosts a variety of user-created ringtones. You can search for ringtones on the site, but the site offers no other real organization—there are no categories to browse.
As you keep scrolling, more and more ringtones are loaded onto the screen for you to choose from. You can preview ringtones on the main page or the dedicated ringtone page where you also have the option to download them. Zedge also offers apps for iOS and Android which surprisingly have better interfaces and let you browse categories. Notification Sounds Notification
Sounds is not the typical ringtone website. It’s a place where you can get ringtones similar to the ones you expect to be pre-loaded to your phone by your phone manufacturer. The ringtones on the website are organized by categories or tags, and there are plenty of both to explore. The handy preview option lets you listen to ringtones quickly, even on mobile devices. Once you
find a ringtone that you like, you can download an MP3 version (for Android devices) or an M4R version (for iPhones). If you have Android, you can download the ringtone directly to your phone. If you have an iPhone, you’ll have to use iTunes to transfer the ringtone to your device. One thing to keep in mind about Notification Sounds is that most of the ringtones they host are
meant to be used for notifications, not ringtones, so they’re pretty short. If you’re looking for ringtones for calls, the selection is more limited. Melofania Melofania is an amazing website for ringtones with a ton of features. Not only can you browse the music of various artists and download their ringtones, but you create ringtones from YouTube videos or even upload your own music.
You can find your favorite ringtones using the search function on the top, and then preview the ringtone on its page. You’ll find a few different variations of the ringtones to choose from. Once you’ve selected a ringtone you like, click the Android or iPhone button and the ringtone for the specific format you need. And once again, Android users can download directly to their phone,
but iOS users will need to use their computer and iTunes as an intermediary. Important Note: As we’ve mentioned, downloading ringtones made from popular songs is infringing on copyright. Therefore we recommend that you use Melofania only for the music that you legally own and have the right to modify and use as a ringtone. MyTinyPhone MyTinyPhone has a gigantic
collection of ringtones totaling over half a million. The ringtones are neatly organized into multiple categories like Jazz, Rock, Themes, Voice, Fun, and more—making them easy to browse. Each ringtone has a star rating and a view count, which makes it quick to filter popular ringtones. One small annoyance, though, is that you can’t just click the big play button shown on the
category pages to sample the ringtone. Clicking it takes you to that ringtone’s page, where you can then listen to it. It’s kind of a drag. Still, it’s worth putting up with for the huge selection and solid categorization. You can download ringtones in either MP3 or M4R format. Audiko Audiko is another popular website that lets you download user-created ringtones. It also lets you create
your own ringtones by uploading your favorite songs. On the homepage, you’ll see the most popular ringtones, SMS ringtones, and the top artists in your country. Scroll down a bit and you’ll find links to popular genres that you can check out. When you open a specific ringtone’s page, you’ll see an option to listen to the tone and its variations. If you like the ringtone, you can click
the download button to start the process. Unfortunately, you’ll have to create an account to download ringtones from Audiko, but the upside is that all your downloaded ringtones are saved in your account, and you can download the iOS or Android versions for them anytime you like. Audiko does have an Android App, which is free to use and does all the things that you can do on
the website. A paid iOS app is also available for $0.99, but we suggest you not bother with that. It has the same functionality as the free website, and you’re going to need your computer and iTunes to transfer the ringtone to your iPhone anyway. Image Credit: Gts/Shutterstock achutam keshavam flute ringtone download. achyutam keshavam flute ringtone free download.
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